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I – Introdução ao AutoCAD 
 

Capacidades a adquirir nesta aula: 

a) Compreender o sistema de coordenadas absolutas e relativas em AutoCAD; 

b) Desenhar figuras geométricas simples, selecionar o tipo de letra; 

c) Saber editar as figuras, utilizando COPY, ERASE e MOVE; 

d) Saber utilizar as ferramentas de apoio SNAP, 2D OBJECT SNAP; GRID, ORTHO, ZOOM; 

e) Saber gravar e recuperar os desenhos; 

f) Saber utilizar adequadamente os tipos e espessuras de linhas; 

g) Desenhar figuras geométricas mais complexas, incluindo elipses, polígonos e arcos; 

h) Utilizar ferramentas de produtividade tais como ROTATE, OFFSET e MIRROR; 

i) Saber editar as peças utilizando EXTEND e TRIM. 

 

 

 

1. Sequência de passos na abertura do AutoCAD 

 

Abrindo o programa Autocad 2020 surge o menu da figura abaixo. Para começar a trabalhar deve-se 

clicar em “Start Drawing”. 

 

 
 

 

Surge uma folha de desenho com o nome “Drawing1”, correspondente à folha de desenho. Podem 

abrir-se novas folhas de desenho clicando em “+” na barra que contém as já criadas. 
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As folhas assim criadas deverão ser guardadas em File -> Save as -> e selecionar a pasta onde vão ser 

guardados os ficheiros utilizando o explorador do Windows. A extensão dos ficheiros deve ser dwg. 

 

 
 

Encontra-se visível a ferramenta de comando, que deve estar preferencialmente colocada na parte 

inferior, em toda a sua extensão, arrastando a barra pelo canto direito. 
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As cores de fundo e outras características de aparência podem ser alteradas clicando no botão direito 

do rato e na janela abaixo indicada, selecionar Options -> Display. 

 

        
 

Pode, por exemplo, alterar-se a cor de fundo em Colors -> Drawing Window Colors -> Color, 

finalizando com “Apply and Close”. 
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2. Ajudas de desenho do AutoCAD 

 

No canto inferior direito existe um conjunto de ferramentas que deve estar visível. Podem colocar-se 

visíveis colocando o rato em  e com a tecla esquerda do rato abrir o menu e selecionar as 

ferramentas que se deseja. 

 

 
 

Deverão estar visíveis as seguintes ferramentas: 

 

Coordinates  Coordenadas 

Grid 
 

Grelha 

Snap mode 
 

Posiciona cursor nos pontos 
da grelha 

Dynamic input 
 

Dimensões dinâmicas 

Ortho mode 
 

Ortogonal 

Object snap tracking 
 

Alinhamento em função de 
pontos de referência 

2D object snap 
 

Posicionar cursor em pontos 
de referência 

Line weight 
 

Espessura de linha 

 

Em cima de um ícone, clique no botão do lado direito do rato e surge a janela que permite ativar o 

snap, o grid, alterar o espaçamento do grid e do snap. 

 

A instrução line weight deve estar sempre ativa. 
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A ativação dos comandos anteriores, pode ser efetuada clicando com o rato em cima dos ícones, 

tomando estes a cor de fundo azul. 

 

 
 

Com o curso em cima do ícone 2D object snap, clicando na tecla esquerda do rato, selecionando Object 

snap settings, que abre uma nova janela permitindo ativar o tipo de pontos que pretende agarrar. 
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3. Comandos de desenho 

 

É possível colocar as barras de ferramentas no ambiente de trabalho com Tools ->Toolbars -> 

AutoCAD, surgindo uma lista. Selecionando uma barra de ferramentas surge automaticamente no 

ambiente de trabalho podendo posteriormente ser localizada no local mais conveniente pelo 

utilizador. 

 

 
 

Procure familiarizar-se com os seguintes comandos: 

 

TOOLBAR Draw 

 
 

 

TOOLBAR MODIFY 

 
 

TOOLBAR Zoom 
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 TOOLBAR DRAW  TOOLBAR MODIFY 

 Line  Erase 

 Construction line  Copy 

 Polyline  Mirror 

 Polygon  Offset 

 Rectangle  Array 

 Arc  Move 

 Circle  Rotate 

 Ellipse  Trim 

 Ellipse arc  Scale 

 Point  Fillet 

 Text  Explode 

 

4. Coordenadas relativas 

 

@ Permite introduzir coordenadas relativas. 

 

5.1 (@ X, Y, Z)  

 

5.2 (@ d < ) d=distância e  o ângulo   

 
 

 

5. Definição de camadas, tipo da linha e espessura de linha 

 

Toolbar Layers 

 
 

A barra de ferramentas Layers possibilita a construção de desenhos em níveis diferentes, podendo 

estar ou não visíveis.  

 

Os desenhos são feitos numa ou em várias camadas (“layers”) que se devem formatar quando se criam. 
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Para criar uma nova camada selecione a instrução Layers Properties Manager na barra de ferramentas 

“Layers”. Surge uma janela com todas as camadas predefinidas pelo sistema. 

 

 
 

As camadas que se encontram predefinidas podem ser mantidas ou apagadas. Para as apagar deve 

selecioná-las, clicar na tecla direita do rato e pressionar a instrução delete. 

 
 

Para criar um novo grupo de camadas selecione a instrução New Group Filter que se encontra: 

 
 

Surge um novo grupo a que deve dar um nome 

 
 

Selecione o grupo que acabou de criar e clique em New Layer para adicionar uma nova camada. 

 
 

Surge do lado direito a nova camada com as definições por defeito, a que deve dar um nome e formatar 

a cor, o tipo e a espessura da linha. 
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Para as alterar basta clicar duas vezes em cima da cor, do tipo ou da espessura da linha predefinida e 

selecionar na janela a que se deseja utilizar. 

 
 

 

Toolbar Properties 

 
 

A cor, espessura e tipo de linha devem preferencialmente ser formatados na layer, aparecendo na 

barra Properties como “ByLayer”. No entanto, podem alterar-se como se mostra nas figuras seguintes. 
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Podem acrescentar-se tipos de linhas no Type line crontrol, quer quando se formata a layer quer na 

barra de ferramentas Properties. Para tal deve selecionar-se a opção other surgindo uma janela. 

Selecionando a instrução load surge uma nova janela com os tipos de linha disponíveis no AutoCAD. A 

inclusão de um novo tipo de linha faz-se selecionando e clicando OK. 

 

 
 

 
 

 

Ícones importantes 

 

Novo  

Abrir  

Gravar  

 

 

 



                    Desenho Técnico Assistido por Computador 

__________________________________________________________________________________________ 
Departamento de Engenharia Rural 

Ana Cristina Gonçalves   11 

6. Definição do estilo do ponto 

 

Menu FORMAT / POINT STYLE  

 

   
 

 

7. Divisão de um objeto num qualquer número de peças  

 

Pode dividir-se um objeto num qualquer número de peças iguais ou dividir em bocados com uma 

medida predefinida com as ferramentas do Menu DRAW -> POINT -> Divide 
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8. Ensino presencial 
 

8.1. Desenhe as seguintes figuras (o espaçamento da grelha é 10 unidades) 

 

8.1.1      8.1.2 

 

  
 

8.1.3 Transforme as duas linhas com 90 mm da figura da esquerda na figura do meio utilizando apenas 

OSNAP ao ponto do fim (ENDPOINT) e ao ponto do meio (MIDPOINT). Pode obter a estrela da direita 

utilizando o comando espelho (MIRROR). 

 

 
 

8.1.4 Desenhe um círculo com raio de 50 mm. Desenhe um polígono inscrito e outro que circunscreva 

o círculo (utilize SNAP ao centro para colocar os polígonos no centro do círculo). 
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8.1.5 Desenhe um hexágono com raio de 60 mm. Desenhe 6 hexágonos no seu interior, utilizando um 

OFFSET de 10 mm. 

 

 
 

8.1.6 Desenhe o triângulo com raio de 50 mm. Inscreva a elipse na base, utilizando SNAP (ao fim) 

(altura da elipse 25mm). Obtenha mais quatro elipses utilizando o OFFSET de 10 mm. Utilizando corte 

(TRIM) limpe as elipses fora do triângulo. Utilizando o espelho (MIRROR) obtenha a parte de baixo. 

Finalmente rode o objeto -45º.  

 

 
 

 

8.1.7 Desenhe uma elipse com 75 mm de comprimento e 25 mm de raio. Divida-o em 28 peças 

(POINT>DIVIDE). Aumente o tamanho dos pontos (POINT STYLE) para serem visíveis. Desenhe 6 arcos 

ligando pontos opostos da elipse, passando pelo seu centro (SNAP ao ponto e OSNAP ao centro da 

elipse). Limpe a figura. Finalmente amplie (SCALE) a parte do meio em 10%. 
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9. Trabalho não presencial 
 

9.1 Desenhe as seguintes figuras (o espaçamento da grelha é 10 unidades). 

 

9.1.1 9.1.2 

 
 

9.1.3 9.1.4 

  
9.1.5 9.1.6 

 
 

9.1.7 9.1.8 

  

 



                    Desenho Técnico Assistido por Computador 

__________________________________________________________________________________________ 
Departamento de Engenharia Rural 

Ana Cristina Gonçalves   15 

9.1.9 9.1.10 

  

9.1.11 9.1.12 

 

 

9.1.9 9.1.14 

  

9.1.15 9.1.16 

 
 

9.1.17 9.1.18 

 
 

 

9.1.19 9.1.20 
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9.1.21 9.1.22 

  
 

9.2 

Normalização: Desenhe a esquadria e a legenda numa folha A3 de acordo com norma NP-204 (ligue o 

comando ORTHO). Guarde esta folha para utilizar sempre que precisar. 
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II – Projeções e cotagem 
 

Capacidades a adquirir nesta aula: 

a) Utilizar a cotagem para indicar a forma e a localização dos elementos de uma peça; 

b) Selecionar criteriosamente as cotas, as vistas onde devem ser inscritas e a sua orientação; 

c) Aplicar as técnicas de cotagem de modo a garantir a legibilidade, simplicidade e clareza do desenho 

em AutoCAD; 

d) Apresentar os desenhos com as cotas numa camada diferente; 

e) Solicitar ao computador propriedades dos objetos desenhados. 

 

1. Definição e formatação da cotagem 

 

1.1 Toolbar Dimension 

 
 

 Dimensão linear 

 Dimensão alinhada 

 Dimensão radial 

 Dimensão diametral 

 Dimensão angular 

 Dimensão paralela 

 Dimensão contínua 

 

Dimension styles  - Permite definir as características dos elementos de cotagem. 

 

 
 

Para alterar a formatação dos elementos de cotagem deve clicar em Modify. 
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Surge uma nova janela com os menus: Lines, Symbols and Arrows, Text e Primary units, permitindo 

adequar a formatação dos elementos de cotagem à especificidade de cada desenho ou projeto. Para 

tal siga os seguintes passos nas janelas: 

1) Primary units altere Linear dimensions e Angular dimensions, Unit format e Precision, para a 

formatação adequada; 

2) Text pode alterar-se Text height, altere a altura do texto de modo que seja claramente legível; 

3) Symbols and Arrows altere Arrow size, de modo que seja claramente legível; 

4) Text altere Offset from dim line, de modo a que seja adequado à dimensão da altura do texto; 

5) Lines altere Baseline spacing, extent beyong dim lines e offset from origin, de modo a que seja 

adequado à dimensão da altura do texto. 

 

Primary units ajustam-se Linear dimensions e Angular dimensions, Unit format e Precision. 

 
 

Text ajustam-se Text height e Offset from dim line. 
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Symbols and Arrows ajustam-se Arrow size. 

 
 

Lines ajustam-se Baseline spacing, extent beyong dim lines e offset from origin 
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2. Ensino presencial 
 

2.1 A partir da figura da esquerda desenhe a sua projeção de acordo com o método Europeu, de acordo 

com as indicações: 

i) identificação de todos os vértices (de A a J); 

ii) projeção dos vértices em três planos perpendiculares, por exemplo no plano vertical, no plano 

horizontal e plano lateral; 

iii) colocar as vistas de acordo com o método Europeu. 

 

 
 

 

 

2.2 Desenhe o seguinte objeto. 

 

 
 
  

D’’ΞA’’ C’’ΞB’’

H’’ΞE’’ G’’ΞF’’

I’’ J’’

I’’ J’’

A’ΞE’ B’ΞF’

D’ΞH’ C’ΞG’

C’’’ΞD’’’

G’’’ΞH’’’

J’’’ ΞI’’’

B’’’ΞA’’’

F’’’ΞE’’’

A
D

B
E C

F

G

IH

J
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2.3. Projeções ortogonais. Desenhe, segundo o método Europeu, as projeções ortogonais necessárias 

para definir os objetos a seguir indicados (o espaçamento da grelha é 10 unidades e a seta a cinzento 

indica o alçado principal). Proceda à sua cotagem num nível (layer) diferente daquele onde fez as 

projeções ortogonais, utilizando, por exemplo, a cor amarela. 

 

2.3.1 2.3.2 2.3.3 

   
2.3.4 2.3.5 2.3.6 

   
2.3.7 2.3.8 2.3.9 

 
 

 

2.3.10 2.3.11 2.3.12 
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3. Exercícios de projeções ortogonais 
3.1 Desenhe, segundo o método Europeu, as projeções ortogonais necessárias para definir os 

seguintes objetos (o espaçamento da grelha é 10 unidades e a seta a cinzento indica o alçado principal). 

Proceda à sua cotagem num nível (layer) diferente daquele onde fez as projeções ortogonais, 

utilizando, por exemplo, a cor amarela. 

 

3.1.1 3.1.2 3.1.3 

   

3.1.4 3.1.5 3.1.6 

   
3.1.7 3.1.8 3.1.9 

 
  

3.1.10 3.1.11 3.1.12 
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3.1.13 3.1.14 3.1.15 

   
3.1.16 3.1.17 3.1.18 

   
3.1.19 3.1.20 3.1.21 

   
3.1.22 3.1.23 3.1.24 

   
3.1.25 3.1.26 3.1.27 
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3.1.28 3.1.29 3.1.30 

   
3.1.31 3.1.32 3.1.33 

   

3.1.34 3.1.35 3.1.36 

   
3.1.37 3.1.38 3.1.39 

 
 

 

3.1.40 3.1.41 3.1.42 
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3.1.43 3.1.44 3.1.45 

 
  

3.1.46 3.1.47 3.1.48 

 
  

3.1.49 3.1.50 3.1.51 

  
 

3.1.52 3.1.53 3.1.54 

   
3.1.55 3.1.56 3.1.57 
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3.1.58 3.1.59 

  

3.1.60 3.1.61 

  
3.1.62 3.1.63 

 
 

3.1.64 3.1.65 
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3.1.66 3.1.67 

  
3.1.68 3.1.69 

  
3.1.70 3.1.71 

 
 

3.1.72 3.1.73 
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3.1.74 3.1.75 

 
 

3.1.76 3.1.77 

  
3.1.78 3.1.79 

 
 

3.1.80 3.1.81 
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3.1.82 3.1.83 

  

3.1.84 3.1.85 

  
3.1.86 3.1.87 

 
 

3.1.88 3.1.90 

  
3.1.100 3.1.101 
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3.1.102 3.1.103 

  

3.1.104 3.1.105 

  
3.1.106 3.1.107 

  
3.1.108 3.1.109 
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III– Perspetivas 
 

Capacidades a adquirir nesta aula: 

a) Desenhar rigorosamente a perspetiva de qualquer objeto; 

b) Desenhar a perspetiva de um objeto a partir da sua representação em vistas múltiplas 

 

1. Seleção de grelha isométrica 

 

Na elaboração de uma perspetiva deve usar-se a grelha isométrica. 

 

Ao colocar o cursor na barra de ferramentas inferior, clique no botão do lado direito do rato. Na janela 

que surge, clique em Settings e na janela Drafting Settings em Snap type selecione a instrução 

Isometric snap. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



                    Desenho Técnico Assistido por Computador 

__________________________________________________________________________________________ 
Departamento de Engenharia Rural 

Ana Cristina Gonçalves   32 

2. Ensino presencial 
 

2.1 Na visualização das vistas em volume haverá que ter em atenção a relação 

observador-objeto-plano de projeção. Assim, quando se analisa a planta deve ter-se a noção que se 

está a ver o objeto de cima, se for o alçado principal será de frente e se for o alçado lateral de lado. A 

partir da figura a) desenhe a sua perspetiva, de acordo com as indicações: 

i) identificar as vistas, na figura a); 

ii) fazer a análise conjunta de duas vistas identificando as arestas comuns às duas e analisar todas 

as vistas em conjunto, para identificar todos os vértices e arestas; 

iii) identificar de todos os vértices (de A a I) e arestas (figura b); 

iv) desenhar os vértices e arestas ao longo dos eixos isométricos, obtendo-se assim a perspetiva 

(figura c) 

 

 
 

 

 

 

 

 

 

  

a)

IΞG

DΞH

A

B C

D

F

H

G
I

A

B C
FΞG

EΞHD ΞA

B
I

C

I

B ΞA

EΞF

D

GΞH

b) c)
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2.2 As figuras seguintes representam as projeções ortogonais de objetos. Desenhe cada um desses 

objetos em perspetiva axonométrica isométrica (o espaçamento da grelha é 10 unidades). 

 

2.2.1 2.2.2 2.2.3 

   

2.2.4 2.2.5 2.2.6 

   
2.2.7 2.2.8 2.2.9 

   
 

2.2.10 2.2.11 
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3. Exercícios de perspetivas 
As figuras representam as projeções ortogonais de um objeto pelo método Europeu. Desenhe os 

objetos em perspetiva axonométrica isométrica (o espaçamento da grelha é 10 unidades). 

 

3.1.1 3.1.2 3.1.3 

   
3.1.4 3.1.5 3.1.6 

   
3.1.7 3.1.8 3.1.9 

   
3.1.10 3.1.11 3.1.12 

   

3.1.13 3.1.14 3.1.15 
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3.1.16 3.1.17 3.1.18 

   
3.1.19 3.1.20 3.1.21 

   
3.1.22 3.1.23 3.1.24 

   
3.1.25 3.1.26 3.1.27 

   
3.1.28 3.1.29 3.1.30 

 

  
3.1.31 3.1.32 3.1.33 
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3.1.34 3.1.35 3.1.36 

   
3.1.37 3.1.38 3.1.39 

 
  

3.1.40 3.1.41 3.1.42 

 
 

 

3.1.43 3.1.44 3.1.45 
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3.1.46 3.1.47 3.1.48 

 
 

 

3.1.49 3.1.50 3.1.51 

   
3.1.52 3.1.53 3.1.54 

  
 

3.1.55 3.1.56 3.1.57 
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3.1.58 3.1.59 

  
3.1.60 3.1.61 

 

 
3.1.62 3.1.63 

 
 

3.1.64 3.1.65 
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3.1.66 3.1.67 

  
3.1.68 3.1.69 

  
3.1.70 3.1.71 

 
 

3.1.72 3.1.73 
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3.1.74 3.1.75 

 

 

3.1.76 3.1.77 

 
 

3.1.78 3.1.79 

 
 

3.1.80 3.1.81 
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3.1.82 3.1.83 

  
3.1.84 3.1.85 

 
 

3.1.86 3.1.87 

  

3.1.88 3.1.89 
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3.1.90 3.1.91 
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IV – Desenho a três dimensões, cortes e secções 
 

Capacidades a adquirir nesta aula: 

Aspetos complementares de desenho a 2D 

a) Saber abrir e ocultar os vários TOOLBARS. 

b) Utilizar MULTILINE; 

c) Modificar objetos desenhados utilizando EXPLODE; 

d) Editar Poli-linhas. 

Construção de peças a 3D 

a) Transformar linhas e arcos em poli-linhas; 

b) Utilizar os comandos REVOLVE e EXTRUDE para obter objetos 3D simples; 

c) Utilizar várias janelas e pontos de vista (VIEWPOINT). 

Cortes e secções 

a) Saber as normas de desenho de cortes e secções; 

b) Decidir sobre a necessidade de recorrer a cortes ou secções para representar completamente uma 

peça em projeções ortogonais; 

c) Saber optar entre um corte ou uma secção; 

d) Optando por um corte, selecionar o mais adequado; 

 

1. Aspetos complementares do desenho a 2D 

 

Na barra de ferramentas Draw o ícone Hatch,  permite preencher uma área com um determinado 

padrão. Após a seleção do ícone Hatch: 

Pick internal point or [Select objects/Undo/seTtings]: t 

Surge uma janela. 

 
 

Selecione o padrão pretendido em Pattern. Com exceção do padrão Solid, deve também selecionar o 

ângulo (Angle) e a escala (Scale) pretendida, tendo o cuidado na sua adequação à dimensão do 
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desenho. Para preenchimento da área deve selecionar em Boundaries, Add: Pick points ou Add: Select 

objects. Clique na zona do desenho pretendida e faça OK. 

 

 

2. Transformação de linhas e arcos em poli-linhas 

 

Toolbar Modify II 

 
 

Para transformar linhas e arcos em poli-linhas selecione Edit polyline, ,na barra de ferramentas 
“Modify II”. Esta tarefa executa-se seguindo as instruções da linha de comando, podendo ser efetuada 
de duas formas (Opções A e B). Para cada opção indica-se com letra normal as instruções da linha de 
comando e indica-se com letra a negrito as respostas a colocar na referida linha de comando. As linhas 
e os arcos devem intersetar-se e não deve haver linhas sobrepostas para se fechar a poli-linha. 
 

2.1. Opção A 

Select polyline or [Multiple]: 

Clicar em cima de uma linha ou arco do objeto 

Object selected is not a polyline 

Do you want to turn it into one? <Y> y 

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: j 

Select objects: 

Selecione as linhas e arcos 

enter 

 

2.2 Opção B 

Select polyline or [Multiple]:m 

enter 

Select objects: 

Selecione as linhas e arcos 

enter 

Convert Lines, Arcs and Splines to polylines [Yes/No]? Y 

enter 

Enter an option [Close/Open/Join/Width/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: J 

enter 

Enter fuzz distance or [Jointype] <0.000>: 0 

enter 

Enter an option [Close/Open/Join/Width/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: C 

enter 

enter 
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3. Desenho a 3D 

 

A barra View permite a visualização do objeto a duas ou três dimensões. Na visualização a 2D pode 

optar por desenhar na vista de cima (Top), na vista de baixo (Bottom), na vista da esquerda (Left), na 

vista da direita (Right), na vista da frente (Front) ou na vista de trás (Back). Na visualização a 3D poderá 

optar pela vista SW isometric, SE isometric, NE isometric ou NW isometric. 

 

Antes de iniciar a elaboração de um objeto a 3D, deve selecionar, na barra de ferramentas View, a 

vista a duas dimensões mais adequada. 

 

Toolbar View  

 
 

Toolbar Modelling 

 
 

Toolbar Render 

 
 

A ferramenta Modelling permite a elaboração de objetos a três dimensões, com as instruções Box, 

Wedge, Pyramid, Sphere, Cylinder, Torus, Pyramid e Helix. Após clicar na instrução deverá seguir os 

passos indicados na linha de comandos. 

 

Os objetos a 3D podem também ser construídos a partir de desenhos a 2D com as instruções Revolve 

ou Extrude. Com esta instrução devem construir-se os objetos a 2D e usar a ferramenta Edit polyline 

para fechar os polígonos. 

 

A instrução Revolve  usa-se quando se pretende construir um objeto e 3D a partir da sua projeção 

e de um eixo de simetria. Devem seguir-se os seguintes passos, que se encontram na ferramenta de 

comando: 

select objects to revolve: selecione o objeto 

Specify axis start point or define axis by [Object/X/Y/Z] <Object>: Com o rato defina o eixo 

selecionando o primeiro ponto que define um segmento de reta  

Specify axis endpoint: Com o rato defina o eixo selecionando o segundo ponto que define um 

segmento de reta  

Specify angle of revolution or [STart angle] <360>: 360 

 

A instrução Extrude  usa-se quando se pretende construir um objeto a 3D a partir da sua projeção 

e de uma direção perpendicular à da projeção.  Devem seguir-se os seguintes passos, que se encontram 

na ferramenta de comando: 

Select objects to extrude: selecione o objeto 

Specify height of extrusion or [Direction/Path/Taper angle] <23.521>: Indique a altura de extrusão 
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4. Colocação das ferramentas slice e section na barra Modelling 

 

Os comandos para efetuar os cortes e as secções não se encontram incluídos em nenhuma barra. No 

entanto, poderá colocar estas duas operações na barra Modelling, procedendo do seguinte modo: 

 

No menu View abrir o menu Toolbars 

 
 

Abre uma nova janela, Customizations User in All Files, na qual se vai selecionar a instrução Slice. 

Arrasta-se para o menu Modelling e faz-se Apply na janela Customizations User in All Files. 

 

      
 

A barra Modelling ficará com a instrução de Slice . 

 
 

Procede-se do mesmo modo para adicionar a instrução Section . 
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A instrução Slice permite gerar cortes em objetos 3D. Para fazer os cortes devem seguir-se as seguintes 

instruções: 

Criar uma layer (Corte) com cor diferente da layer de desenho do objeto 

Copiar o objeto para a layer corte 

Ativar o OSNAP 

Selecionar Slice , na ferramenta de comando  

Select objects to slice: selecionar o objeto 

enter 

Specify start point of slicing plane or [planar Object/Surface/Zaxis/View/XY/YZ/ZX/3points] 

<3points>: selecionar um semiplano, XY ou YZ ou ZX 

enter 

Specify a point on the XY-plane <0,0,0>: selecionar um ponto no objeto 3D 

Specify a point on desired side or [keep Both sides] <Both>: b 

Apagar o corte em que não se vê o seu interior 

 

A instrução Section permite gerar seções em objetos 3D. Para fazer os cortes devem seguir-se as 

seguintes instruções: 

Criar uma layer (Secao) com cor diferente da layer de desenho do objeto 

Ativar o OSNAP 

Selecionar Section , na ferramenta de comando  

Select objects to slice: selecionar o objeto 

enter 

Specify start point of slicing plane or [planar Object/Surface/Zaxis/View/XY/YZ/ZX/3points] 

<3points>: selecionar um semiplano, XY ou YZ ou ZX 

enter 

Specify a point on the XY-plane <0,0,0>: selecionar um ponto no objeto 3D 

Formatar a seções em função das regras (cf. Apontamentos teóricos de Desenho Técnico Assistido 

por Computador). 
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5. Ensino presencial 
 

5.1 Desenhe a seguinte vista cortada. O espaçamento da grelha é 10 unidades. 

 
 

5.2 Para desenhar o seguinte objeto, pode desenhar apenas a parte exterior e utilizar o comando offset 

(25 mm) para obter a parte interior. No entanto para poder fazer isso, primeiro precisa de transformá-

lo numa poli-linha. 

 

   
      Desenho final            Desenho intermédio 

 

5.3 Desenhe os seguintes objetos a 3 dimensões. Faça os cortes e as secções segundo a vertical e a 

horizontal, que achar mais conveniente, selecionando o plano mais adequado. 

Nota: de modo a visualizar melhor o objeto a 3 dimensões, após a sua construção aplique o comando 

HIDE. 

 

5.3.1 Carrinho de linhas. A secção do objeto, passando pelo eixo central está apresentada na figura 

seguinte (o espaçamento da grelha é 10 unidades). Use o comando  REVOLVE. 
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5.3.2 Desenhe a peça seguinte de acordo com as indicações fornecidas (o espaçamento da grelha é 

10 unidades). Transforme-o numa placa com 50 de altura utilizando EXTRUDE, . Desenhe dois 

cilindros com 60 de altura na placa. Em seguida subtraia os cilindros da placa . 

 

    
 

5.3.3 Desenhe este objeto utilizando os seguintes comandos:     . Considere que o 

diâmetro dos hexágonos é 10 mm, a altura da base 20 mm, a altura dos hexágonos 35 mm  e a altura 

do cilindro central 40 mm. 

   
 

5.3.4 Desenhe a peça seguinte a 3D, utilizando os comandos indicados:     .  A peça 

tem 50 mm de altura. 
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5.4 Desenhe as peças a 3D (o espaçamento da grelha é 10 unidades). Faça os cortes e as secções, que 

achar mais conveniente, selecionando o plano mais adequado. 

 

5.4.1  5.4.2  

 

 

 

 

5.4.3  5.4.4  

 
   

 

5.4.5  

  
5.4.6  
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6. Exercícios de construção a 3D, cortes e secções 
 

Desenhe as peças a 3D (o espaçamento da grelha é 10 unidades). Faça os cortes e as secções, que 
achar mais conveniente, selecionando o plano mais adequado. 

 

6.1  6.2  

 

 

 
 

6.3  6.4  

 

 

 
 

6.5  6.6  

 
 

  

6.7  6.8  

   
 

6.9  6.10  
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6.11  6.12  

    

6.13  6.14  

    

 
 

6.15  

  
6.16  

  
6.17  
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6.18  

 
 

6.19  

  
6.20  

 
 

6.21  

  
6.22  
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6.23  

  

6.24  

  

6.25  

 
 

6.26  

  

6.27  

  

6.28  
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6.29  

 
 

6.30  

  
6.31  

 
 

6.32  

  
6.33  
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6.34  

  

6.35  

 
 

6.36  

 
 

6.37  

 
 

6.38  
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6.39  

 
 

6.40  

  
6.41  

 
 

6.42  

  

6.43  
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6.44  

 
 

6.45  

 

 

6.46  

 

 

6.47  
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6.48  

  
6.49  

 

 

6.50  

  

6.51  
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6.52  

 
 

6.53  

 

 

6.54  

 

 

6.55  
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6.56  

 
 

6.57  

 
 

6.58  

  
6.59  
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6.60  

 
 

6.61  

  
6.62  

 

 

6.63  
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6.64  

  
6.65  

  
6.66  

 
 

6.67  

 

 

6.68  
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6.69  

 
 

6.70  

  
6.71  

 
 

6.72  

 
 

6.73  
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6.74  

 
 

6.75  

 
 

6.76  

 

 

6.77  
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6.78  

 

 

6.79  

 

 

6.80  

 

 

6.81  
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6.82  

 

 

6.83  

 
 

6.84  

 

 

6.85  

 

 

 


